PRODUCING AUDIO-VISUALS (AVs) in PROSHOW GOLD®
By Philip Smithies

Although I've devoted the majority of this article to describing how to produce an AV in ProShow Gold, I'll start by summarising the
software available for PCs.

FREE AV SOFTWARE FOR PCs

| don’t know of anyone who has tried free software. The reviews | have read suggest that the programmes often have serious limitations (e.g. no way of
adding text or saving in an exportable format. Technical support will be very limited) and you are likely to have to pay for an upgrade to a fully functional
product. Beware that some software may be associated with the undesirable adware, etc. | would urge you to read impartial reviews before proceeding
further. That said, the following reviews may be of interest:

http://www.techsupportalert.com/content/dvd-slideshow-gui.htm-0

http://www.techsupportalert.com/content/socusoft-photo-video-converter.htm-0.

NON-FREE SOFTWARE FOR PCs

The best-known products are PicturesToExe (PTE) (Essentials or Deluxe), ProShow Gold (PSG) and ProShow Producer (PSP)

PicturesToExe is more popular in the UK than ProShow products. Just as DelLuxe is the big brother of Essentials, so Producer is Gold’s big brother. All can
be downloaded on a trial basis.

These costs were correct on 14 July 2017.

ProShow Gold: £53.78; ProShow Producer: £192.16. Cheapest Upgrade from Gold to Producer: £154.29; PicturesToExe £53.05 or £106.86 depending on
the version (“Essentials” or “DeLuxe”).

ProShow offer a fifteen percent discount to my contacts on any product purchased before Christmas. ProShow Gold would therefore cost you around £46.
Please contact me for further details (philip.smithies@hotmail.co.uk)

ProShow Main Website:

http://www.photodex.com/

http://www.photodex.com/try Trial Download for two weeks
Tutorials — online guides to the software
http://files.photodex.com/docs/manuals/ProShowProducer8.pdf
http://files.photodex.com/docs/manuals/ProShowGold8.pdf

PicturesToExe Main website:

http://www.wnsoft.com/ Trial Download for thirty days
Tutorials:

http://docs.picturestoexe.com/en/main
http://docs.picturestoexe.com/en/main_menu/file

PicturesToExe (Essentials) is about the same price as ProShow Gold. It features keyframes (extremely useful) which Gold still does not. There is little
difference in the quality of the finished product, so in that respect it doesn’t matter which you use. Shows can be published as executables or movie files.
The latter are more flexible and of very high quality but are much larger in size. At close viewing distances, the quality of PTE executables is significantly
better than ProShow’s. The ProShow products seem (to me) to be more user-friendly and easier to use. If | were starting from scratch, | would find it very
difficult to decide which product to go for.

YOUTUBE TUTORIALS

YouTube has a large number of excellent video tutorials. Just search for “name of Product” and “tutorials”

OTHER PRODUCTS

Links which compare AV software for PCs:
http://photo-slideshow-software-review.toptenreviews.com/index.html
http://www.toptenreviews.com/software/multimedia/best-photo-slideshow-software/

| don’t know of anybody in Tonbridge Camera Club — or indeed elsewhere — who has any first-hand experience of the other products (many of which are
reviewed very positively.

MAC SOFTWARE

| have no direct experience of Mac software. However, Fotomagico seems to be very popular (https://boinx.com/fotomagico/). Google “slide show
software for Macs” for alternatives.

EASE OF USE OF SOFTWARE
AV/“Slide Show” software is much more intuitive and easy to use than photo editing software like Photoshop. The guide that follows just gives the basics —
ProShow and PicturesToExe are very powerful programmes indeed and capable of much much more than is shown here.

VIEWING THIS DOCUMENT
If it’s hard to see the contents of the screenshots, zoom in by using “CTRL + scroll wheel”

Important note:The guide which follows describes the stages in creating an AV in ProShow Gold Version 5. The current release is Version
8 but the basics remain the same. Other software is very similar.
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Double-click on the desktop icon to open the programme.

SETTING THE SHOW PARAMETERS
FIG 1

Click on Show—>Show Settings
The “Show Settings” Dialogue Box appears.
1 Change these values to “0”
2 Untick this box (to prevent the irritating

hatched borders from appearing (shown - ﬁ
=

in a few screenshots but removed from
many).

Note: sometimes the “New Empty Show” Box
appears when ProShow is opened. Untick the
“Show at Start-up” box and close.

You are now ready to create the show.

OPENING SCREEN
FIG 2

Create a title (this does not have
to be the same as the filename and
may be changed at any time)

Decide on the *Aspect Ratio
(4:3, 16:9 or custom)
No need for a thumbnail

Then press “OK” at the bottom
right.

*The Aspect Ratio used by the most
clubs’ projectors is 4:3 but most
monitors and some projectors are 16:9.
Most of my AVs use the 16:9 ratio.
Either ratio can be played on any
computer. If, for example, you played a
16:9 show on a 4:3 monitor, there
would be black spaces at the top. You
can change the aspect ratio at any time,
but you would have to make some
adjustments to the images.

The opening screen resembles FIG 2 but possibly with white font on a black background. This can easily be changed (see next page)
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Navigate to the relevant folder(s)
to access the images you'll be

using

The “Preview Screen”

Click and drag at these points if you wish to resize the main windows:

Timeline / slide list
Default is “Slide List” tab which is

generally more useful
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See section on “FILE TYPES” and “IMAGE SIZES” on page 14.

FIG 3



SAVING and STORING PROSHOW FILES

| suggest that you create a new folder (with a shortcut on the desktop and/or taskbar) so that everything is stored and saved in the same
place (with subfolders if required). This will make organisation so much easier.

No matter what software you use, if you move your images to different folders, the next time you open the show you be told that the files
can’t be found. You will be asked if you want to search for these files. Tick the “Yes” box that appears and follow the on-screen instructions.
However, please note that if you rename images (rather than just move them), the software — understandably — will never find them.

Save your work regularly.

PSG is fairly stable but, like all software, it does have its uncooperative moments. Incidentally, you can UNDO beyond the last save —

back to the state of the show when it was opened. Unfortunately, there is no direct “Revert” option.

IFIN DOUBT...

A basic rule for most Windows programmes: if in doubt, RIGHT-click to bring up a context menu.

PREFERENCES / CUSTOMISING YOUR SHOWS

in fact,

At some stage, it is useful to go to Edit = Preferences to customise your shows e.g. set up standard default times, choose screen colours,
etc. | prefer black font on a lighter background; others prefer the default white font on a black background.

CREATING AN AV USING “THE WIZARD"”
The Wizard Tool has changed enormously since the first version of this guide. | suggest you read pages 110-120 of the User Guide
(http://files.photodex.com/docs/manuals/ProShowGold8.pdf) for an overview of the process.

PREPARING THE SHOW - ADDING SLIDES
Images can be in .jpg, .gif or .png format.
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—see page 5.
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You can change the

slide times and
transition times by
clicking on the

numbers and typing in
new ones. Every
additional slide in the
show you add will
have the same times
as the one before it
but times can be
changed at any time.

OPTIONAL: Ri‘ght-clicklhere and select
“Insert”=> Blank Slide” from drop-down
list (or ALT+B). A blank slide at beginning
(and end) ensures smooth entry into (and
| set the time of the
blank slides to 0.25 seconds

exit from) show.

Navigate to the relevant foldgr and drag the first slide in (alternatively, just double-click
the slide). Add the rest of the slides (singly or in multiple).
Images can be added at any time and to anywhere in show. PSG will put a green tick
and number in the File List by each picture that’s been added to the show. Your screen
will resemble Fig 7. Clicking on an image in either the timeline (the “thumbnail”) or file
list will bring it up on the main (Preview) screen. (Double-clicking brings up the “Slide
options” box.)
The timings in Fig 6 Slide 2 are the default settings that | use for every slide. You can
change all defaults and lots more besides in Edit = Preferences.
You can also drag in slides directly from Windows Explorer (e.g. from “My Pictures”).



http://files.photodex.com/docs/manuals/ProShowGold8.pdf

FIG 7

Whenever you want to see what the show looks
= like, simply click the “Play Button”

To toggle between full-screen and preview screen:
e  EITHER click “ALT + ENTER”

B ¥ 0:00.00/0:12.00

e=Drag along either of these two bars to see a
speeded-up version

A slide can be repositioned by clicking it and moving it using the left (<) and right (>) arrows on the keyboard (below the “K” and “L” keys).
To select more than one slide, use the standard Windows techniques:
e “CLICK” on the first and then “CTRL + click” to select additional slides
e  “CLICK” on the first slide and then “SHIFT + click” on the final slide
Standard useful shortcuts are CTRL+X/C to cut/copy and CTRL+V to paste. The image(s) will be pasted before the image you click on.
Insert a blank slide at the end if necessary.

ESSENTIAL SLIDE ADJUSTMENTS

Double-click on the slide thumbnail at the bottom of the screen (#5 in this case) to be modified and the “Slide Options” dialogue box, with
its three tabs, appears occupying most of the screen. FIGs 8 and 9

ADJUSTMENTS tab

The “Adjustments” tab,
as its name suggests,
enables a large number
of basic (non-
destructive) adjustments

LAYER SETTINGS tab

memm Click on “Layer Settings” tab.
The majority of your images will
not completely fill the available
space because their aspect ratio
is different from your choice in

= Figs 4 and 5 (for example, most = .~  to be made eg add a
e cameras have a 3:2 aspect = = | = border  (Outline)  or
w— . . - e e t t h
—E= I _____ ratio). Adjust the figures here E“:m N c.onvgr 0 monochrome
“ww and/or drag the image/four (illogically called
handles to fill the screen. “Colourise”).

EFFECTS tab
This tab enables you to create image movement such as pans and zooms (in or out) or combinations thereof. In this example, when the
slide is played, the effect will be to zoom in on the building.

Click the “Effects” tab.

: : e e — FIG 10

This button returns settings to
their default values.

Click in the “Starting Position” Box. If necessary, ffhange values for “Starting Position” by changing numbers and/or dragging sliders and/or
dragging the image. Then click on “Ending Position” to make changes there. See FIG 11.
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* The zoom/pan is normally smooth, but may look better as “linear”
in certain cases e.g. a long “pan” with a panoramic image image)

FIG 11

You can move to the next / previous slides by clicking the buttons to the left of the “Preview” button.

Check the effect by clicking “Preview”

You should consider extending the length of the slide if you are using a large zoom (in or out) or sweeping pan. However, as a general
principle, only employ movement for a purpose and not for the sake of it.

Even if you don’t prefer not to use movement, you should, at the very least, use the “Layer Settings” option to ensure that that image fills
the screen and/or is correctly positioned and/or sized.

You might want to explore the “Tilt” and “Rotate” options. ProShow Producer and PicturesToExe feature “keyframes” which enable very
complex motion effects to be created. The absence of keyframes is a weakness of ProShow Gold in my opinion. Contact me if you would
like more information.

TRANSITION EFFECTS l.l

By default, each transition (the way in which one image fades to the next) is a linear cross-fade — shown as
you cI|ck ona transition, this fuII screen box appears with a range of different effects.

VPV PP . P ..y

— i FIG 12

on the slide list. When
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Clicking on any transition effect in this box gives a preview in the top left corner. Irhe drop-down list shows a large range of alternatives.
Double-click on the effect to apply it or click “Apply”. The screen also shows at the bottom right the most recently used effects which can
be applied directly. Don’t overdo the transitions you use — simple is usually best.

CAPTIONS

Double-click on the relevant slide (a blank one if you prefer) then click on the “Captions” tab and the “+” to create captions:

FIG 13

This box in Flg 14 appears:



FIG 14
h Type text here

Choose placement, etc. here

Choose format here

Choose caption behaviour here. “Browse” gives a

preview.

= Clicking on “+” enables the addition of extra
p— captions, with different effects if required.

”

The caption can be resized and repositioned by clicking and dragging, or by typing numbers into the appropriate boxes. In Gold, the caption
lasts just very slightly less than the slide; unfortunately, you cannot alter the duration. Again, don’t overdo the effects.

SOUNDTRACK

Click “Show = Soundtrack”, then “+”, then “Add Sound File”. In the box that appears, navigate to relevant folder and song, click “Open”

usic as described below.
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This is the waveform for the music track. Switching to “Timeline” enables additional changes to be made to the sounds. Many sound
formats can be used but .mp3 is preferable.

(Note: if the song is visible in the folder/slide list on the left, you can just drag it to the timeline)

After you click open, the “Soundtrack” box will appear as shown in Fig 16.



BASIC SOUNDTRACK EDITING
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Click on the “+” and navigate
to add additional music.

You can make some basic
edits by clicking “Edit Fades
and Timing” which brings up
the dialogue box (Fig 17)
below.

Importing music from a CD is
not recommended as the
quality isn’t as high.
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Hold the cursor over each icon to see what it does. For example, you can fade out music, or cut it short using the sliders or entering values
in the boxes. However, it’s normally far more effective to edit music properly. “Audacity” is free downloadable user-friendly music-editing
software which offers a huge range of effects as those in all AV software are very basic indeed. “Audacity” is available for both PCs and
Macs. See http://www.audacityteam.org/download/. (This is one free software | have no hesitation in recommending)

Version 8 has a much-improved “Timeline” window and it is possibly easier to make changes there.

VOICEOVERS/COMMENTARIES

Adding voiceovers/commentaries to create a “documentary” type AV is beyond the scope of this document but straightforward to do — but
very difficult to do well. You will no doubt have heard countless examples of poor voiceovers — creating good ones is an art in itself.

If you're interested in adding voiceovers, Richard Gandon’s informative AV about adding voiceovers/ commentaries to AVs is on YouTube:
https://www.youtube.com/watch?v=PxGLpcajdgE&feature=youtu.be .

It seems nowadays that the most successful AVs in competitions are likely to be in a documentary style.


http://www.audacityteam.org/download/
https://www.youtube.com/watch?v=PxGLpcqjdgE&feature=youtu.be

ADDITIONAL SLIDE ADJUSTMENTS: LAYERS

You can have two (or more) images (“layers”) in the same slide/frame, with effects being set individually for each. To add a second image,
hold down the CTRL key and drag an image from the file list on top of an existing slide. Repeat as many times as desired. Layers are useful
when you want to include images which are square(-ish) or in portrait format side-by-side as in the example below. This avoids having
images only occupying a fraction of the screen —something which looks unattractive.
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Then double-click the image to open the “Slide Options” box and modify each layer as shown in Fig 19:
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Click each layer in the “Layer Settings’ftab to position image.
The two top images are set at -25, 0 and +25, 0, respectively and the zoom is set at 98% . Layers can also be reposition by dragging or using
CTRL +<&orPor—>ory,. A white border (Outline) has been added from the “Adjustments” tab. The bottom layer (which completely fills the
screen) is an image from earlier in the show but modified in the “Adjustments” tab — turned to monochrome (“Colourised”), “Blurred” and
the “Brightness” increased. As mentioned earlier, changes made in the “Adjustments” tab do not affect the original image. The preview
window now looks like Fig 20:

Note: when you first add a layer to a file, it will partially or
totally obscure the layer below, depending on its aspect ratio.
By double-clicking on the slide and opening the “Slide Options”
box, you will see that all the layers are there.




.PNG FILES

Png. files are exceptionally useful as they can be partially transparent thus enabling the creation of countless special effects. Fig 21 is a
basic .png version of the statue in Fig 20

FIG 21

To create this, | made a selection of the figures in the image on the right of Fig 20 in Photoshop. | copied
it to a new file and saved it as a .png file. This preserved only the selection with the background
becoming completely transparent.

Many of the effects seen in AVs can only be achieved by using .png files.

STYLES

This video link is useful, even though it only covers version 4: http://www.youtube.com/watch?v=7rc-WEI| bPg&NR=1.There are a range of
other YouTube videos which may be helpful.

Don’t overdo the use of “Slide Styles”.

PLAYBACK
The show can be played back at any point. (Go to Edit = Preferences to set quality)
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Hold your cursor over these buttons and drag this slider to investigate their effects

INCORPORATING VIDEOS

In http://www.youtube.com/watch?v=gMSgr|PS3ts, Gavin Hoey gives a clear demonstration of how to add and edit video. Because modern
dSLRs can take high-quality videos, AV-users are increasingly making use of this facility. It has to be acknowledged that some in the AV
world frown upon their use (for reasons that escape me).
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SYNCHRONISING PICTURES AND MUSIC

It’s unlikely that the music and the slide show will be exactly the same length. A simple way to address this is to select all (CTRL + A) or
some of the slides and go to:
Audio = Quick Sync — Selected Slides and click “Yes” when prompted.

(‘5_1) ProShow Gold - Philip Smithies - Autumn.psh * F I G 2 3
i File Edit Show Siide ¥R Tools Publish Windflv Help

3 Manage Soundtrack Ctrl+M -
Qe H - ) Y
£ M Ones G Wi Sync Slides to Audio CthT e Syno Music
i Autumn Save Music from CD
m Record Slide Timing
DOORS
b)) EAST ANGLIA Quick Sync - Entire Show Ctr+Q This function is about to adjust the timing for all selected slides
s N b e gty braiitbscondbllasions  ©
EASTBOURNE Quick Sync - Selected Slides to Track Alt+Q
FAMILY
FIREWORKS
FLOWERS =
FRANCE 2009
FRIENDS
GUY'S WEDDING
HALLS OF PLENTY =

Sometimes, if the two times are very close, modifying the timings of one or both end blank slides may be sufficient. | must emphasise that
this is the simple way to deal with the issue and is not suitable if you exactly want to synchronise a particular section of music with a
particular image. If that is the case, you will have to tweak individual slide lengths and/or make use of the “Sync Slide to Audio” button in
Fig 16.

4

ADDING SOUND EFFECTS ON TOP OF EXISTING MUSIC TRACK

somm FIG 25

(30 ,vr.gnnssal{JL]J
CTRL + drag the sound to the slide where you want the sound to begin. Then double-click on the slide:

“FIG 26

(((((

TR
e sophisticated approach.

This is one site which has some free downloadable (.mp3) sound effects: http://www.mediacollege.com/downloads/sound-effects/
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PUBLISHING THE AV — CREATING “MOVIE” FILES and/or EXECUTABLES

Finally, the show must be converted into a playable form — either a movie file (e.g. .avi, .mov or .mp4) or an executable (.exe) or both.
Movie files are much larger and take longer to create but are of higher quality and can be played on both PCs and Macs — and also
“SMART” TVs. External competitions until recently insisted on executables but most now also allow movie files.

CREATING AND PLAYING EXECUTABLES

For full details, see http://www.kcpa.co.uk/wp-content/uploads/PROSHOW-CREATING-EXECUTABLES.pdf

When the show is complete and saved, you can create an executable for use on your own and other computers. To ensure that the show
satisfies competition criteria (i.e. opens instantly at full-screen when the file-name is double-clicked and without an intermediate display),
amend the various settings as described in the link. If you would like your own copy, please contact me on philip.smithies@hotmail.co.uk

Executables can be copied to a CD, memory stick or hard drive and played on any PC (including, of course, the one on which they were
created). Executables cannot be played on TVs or on *Macs whereas movie files can. Executables play automatically when the filename is
double-clicked and no software is needed to do this.

One of the weaknesses of ProShow, in my opinion, is that the quality of executables, at least when viewed closely, is not as good as
PictureToExe’s. | therefore always create a movie file rather than an executable.

Anti-virus software can sometimes refuse to allow executables to play and may quarantine them. One way round this may be to right-click
on the file-name and select “File Insight” from the menu that appears and investigate the options available. Choosing “Trust Now” is highly
desirable.

When executables (.exe) are created, they may be fragmented — sometimes into hundreds of pieces. If you find your executable doesn’t
play smoothly, you might consider defragmenting your computer (particularly an older / less powerful machine).

*PTE apparently now offers the option to create an executable which can be played on a Mac.
CREATING AND PLAYING MOVIE FILES (e.g. .AVI FILES)

Movie files (e.g. .avi files) are a higher quality alternative to executables and are easily created as shown below:
Go to “Publish” = “Video for Web, Devices and Computers” = Video File = AVI. Select MPEG-4 SP 1080 (for .avi format) and then click
“Create”] The file takes much longer to produce than an executaty roughly three minutes for every minute of show. (FIG 27)

() Prifbhow Gold - Ml
: Filg

3 ools [EIEERY Window Help
Publish Show Ctr+P B
. 2 O I3
Menu Theme and Layout Ctrl+Alt+M @4 ‘ - o D ‘

i | Add Blank DVD Bluray Video YouTubglfFacebook

FIG 27

Blu-ray
bVD
LONDON BRSfMUSEUM Executable
LONDON CATHEQg

LONDON GREENWICH
LONDON MAHMON
LONDON NIGHT
LONDON PADDINGTON For the Web »
LONDON PALACES

For Computers
LONDON PARKS |

LONDON POSTCARD FROM Specialty and Legacy Formats

Video for Web, Devices and Computers.
YouTube

Facebook

[ Game Console
[ Media Player 4
[ Mobile Phone 4
[£ PDA J

| set-Top
|5 Video File

= . € Sel

S| LONDON BATTE.. LONDON BATTE... ~LONDON BATTE. [ upec-s sp 260p

6ficannedjpg LONDON BATTE.. LONDON BATTE.. LONDON BATTE...

=

ot MPEG-4

AR

LONNON BATT...

£y é 1 ] napec-s sp 480p 8
. ) []wpec-4 sP 7200
) Flash Video
2 o
LONDN BATTE. TTE LONDON BATTE, MEEC=2 =
[ MPEG-4 b
= a
/ [ Quicktime
8 Video for Archiving or E Save Location | Ask me where to save after cicking Create |~
AW ¥~ . [ Video for Uploading to the
LONJDN BATTE..  LONDON BATTE.. LONDON BATTE.. LONDON BATTE.. LONDON BATTE. Wiidoiws Madla Video | Profie | [+
o
€23 Click here to dowinioad | Create [ Cancelm|
Siide List [T
&

You will see in Fig 27 above that numerous other video/movie file formats (e.g. .mp4 and .mov) can also be created.

The file can be played on “SMART” TVs or with Windows Media Player or other software such as VideoLan VLC. The methods are described
in the next pages.
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PLAYING MOVIE FILES WITH WINDOWS MEDIA PLAYER AND ON MODERN TELEVISIONS

OPTIONAL FIRST STAGE

FIG 28

O Wi Ml Open Windows Media Player. Click

File View Play | Tools | Hel .
— y [Tools] Help Tools=>Options
r 4 . Download
» Libi = N
N Apply media information chan, Tpie ﬁ
(o] ize * St .
e i Plug-ins b | Library I Flug-ins I Privacy I Security I ovD | Networkc In the bOX that appears, flnd the
| Payer | RpMuse | Devees | Bum | Pefomance (G “Derformance” tab.
Eh Library Options... Fimeq ) ) ) )
. i 9 Spedfy connection speed, buffering, and playback settings.
4 [k| Playlists Advanced »y oever i .

(] BEATLES —srerarve rrmerer vorwmcs
(] BEATLES - BACKING TRACKS VOLUME 2
-] BEATLESA-G
| BEATLESA-H

Consider deselecting “Display full-
Simple as This screen controls”. This is not
Played 104 Timed - Ghoose connection speed: essential, and can be reversed and

Played 147 Timeq Connection speed

5] BEATLES H-J The Cave [Shorte odem (100 results in the file playing without
5] BEATLESH - M Played 38 Times ||| |~ Network buffering the toolbar becoming visible when
le| BEATLESL -5 Eides b Th.E Sky @) Use default buffering (recommended) il you move the mouse — Wh |Ch may
(] BEATLESN - Played 57 Times Buffer 5 seconds of content

(5] BEATLES RARITIES Trouble Is My Mi o me or may not be what you want.

(k] BEATLEST-Y Played 96 Times DVD and video playback

k| JAKE BUGG Seen It All [7|Drop frames to keep audio and video, Then C“Ck “ K"

(=] MIKE OLDFIELD Played 8 Times [#]Use video smoothing

k| MEW - PAUL McCARTNEY 1 Can't Write Anof || isplay full-screen controls

(#| PAUL McCARTMEY - VOLUME 8 [#] Turn on Directy Video Acceleration for WMV files

Played 86 Ti
(5] PAUL McCARTNEY - VOLUME s Hin= Videa border color:

[¥] PAUL MCCARTNEY - VOLUME 10 NOT on ¢f Noteto Seff _ =z

[ PAUL McCARTMEY VOLUME 8 Played 82 Times

(=] RECENT SOMNGS Ben Crawley Steel ng by |
| UNRECORDABLE Played 80 Times

k| VARIOUS ARTISTS Cosmic Dancer Apr Help

=] VARIOUS ARTISTS - VOLUME 18 Played 75 Times |

=] VARIOUS ARTISTS - VOLUME 18 NOTON CD e Trye Tt's True

k] VARIOUS ARTISTS - VOLUME 19

Dlaveard 74 Timnar

To play the file from this box, click File>0pen and then navigate to the folder where your file(s) is/are kepf. Double-click the file (Note: if
you want to play more than one file, holgddown “CTRL” and click any other files you also wish to play) and #then click “Open”.

Win, s Media Player F | G 2 9
e Play _Toolsf Help
Open... Ctrl+0

Open URL.. Chl+U
Save as..
Close Ctrl+W Title File name
Create playlist Ctrl+N L TS
Create auto playlist P Open
Save Now Playing list =
e Mo Pl o 2 1 &= » Libraries » Documents » PROSHOW + AVIs- SORTED »
Ve . Organize v New folder
Properties 7 Favorites I?ocuments library N BT
Work offline AVIs - SORTED
ait P Desktop A Name a
= B;ME;T \; — e Libraries A PARKS AND GARDENS.avi
= ) (3 Documents £ PIERS OF THE REALM.avi
»| JAKE BUGG J) Music =
S ep—— L £ PORTRAIT OF BLACKPOOL.avi
L] [ Pictures i
£ PORTRAIT OF BRIGHTON.
(5] NEW - PAUL McCARTNEY B Videos - o
£ PORTRAIT OF CARDIFF.avi

PAUL McCARTNEY - VOLUME 8

[+
b= e (0= R

& Homegroup 2
PAUL McCARTNEY - VOLUME 9 PORTRAIT OF HASTINGS.avi

! A Philip i
e PAUL McCARTNEY - VOLUME 10 NOT ' ot A PORTRAIT OF LINCOLN.avi
[e] PAUL McCARTNEY VOLUME 8 j'c tact £ PORTRAIT OF LIVERPOOL.avi E
5 ontacts - - -
5] RECENT SONGS . £ PRAGUE - CHARLES BRIDGE AND OLD S
-] UNRECORDABLE = b A PRAGUE - COMBINED.avi
=] VARIOUS ARTISTS o WIS £ PRAGUE - ELECTROSHOCK.avi
(| VARIOUS ARTISTS - VOLUME 18 B £ PRAGUE - LEFTOVERS avi
=] VARIOUS ARTISTS - VOLUME 18 NOT f iy Favorites A DRAGIIE . WEST RANK mi 2
Incomplete hd| U s
(] VARIOUS ARTISTS - VOLUME 19
5] VARIQUS ARTISTS - VOLUME 20 NOT 0] File name: PORTRAIT OF LIVERPOOL.avi v [Mediafile pes) T Plection
S M - c
Bicr .USIC Open A Cancel

@, Artist
@ Album L

Wy Soul {with Nitin Sawhney) WMy Soul (with Nitin Sawhne 404 72 Ningspsn

& Genre

Dlarad A3 Timec

Alternatively, and rather more easily, go directly to the folder which contains your shows and either (i) double-click the file name or (ii)
right-click* on the file name and from the menu which appears select “Play with Windows Media Player” or “Add to Windows Media Player
list”.

(*or click the first one and then CTRL + click the others to play a sequence). See FIG 30.
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FIG 30

B,
9"\_)? | . = Computer ~ DATA (F:) = Users = Philip ~ My Documents ~ PROSHOW ~ .AVIs - SORTED -

Organize « éF"Iag.lI w Playal Bum  New folder

[ Favorites Size ame Length
M

B Desktop 391,738 KB _TO THE TOP OF E|jpptesy

4 Dowrloads 221,156KB  POSTCARD FROM i 's Playl

. I r Add to VLC media player's Playlist

& Recent Places 172,424KE  ENGLAND.avi Play with YLC media player
. o 232,321KE MAGICAL MYSTER Add to Windows Media Player list
=l Libraries Play with Windows Media Player

=) Documents 232,821KB MAGICAL MYSTER ~o0c i 3

o) Music 108,518 KB A WINTER'S DAY.: v Norton 360 ’

] Pictures 232,876 KB PORTRAIT OF LIv| 58 Add to archive...

B vid & Add to "TO THE TOP OF EUROPE VERSION 2.rar”

ideos 141,678 KB  LIGHTHOUSE - HU

B Compress and email...

-
a
&
&
a
&
F=
& H £ 136,008KE WIND POWER.avi @ Compress to "TO THE TOP OF EUROPE VERSION 2.rar” and email
omegrou . . .
I & 115,535KB UNIVERSAL SOLDI  Restore previous versions
a
&
&
a
&
F=

400,145KB SWITZERLAND 3-  Sendto »
169,559KB DEAR GOD [#x3].i o0
111,435KE SCENTED PATHS.Z  Copy

;‘; Computer
ﬂ_‘:. Local Disk {Z:)
a Elements (E:)
—w DATA (F2)
—a My Passport {L:)
—a My Passport (M:)

221,990KB THESCRAWLOF1 oo gpores s
202,507KE LOCK! AROUND..  Delete
307,357KE PORTRAIT OF PRY  Mename

Note: | use VideoLan/VLC Media Player as my default player — hence the VideolLan icon by each filename.

The show begins to play as shown in FIG 31 (with close-up of corner shown by main screenshot):

FIG 31

T w

View full screen

Click on the “View Full Screen” and the show(s) will play completely filling the screen. Alternatively, or if this icon is not present, press the
“F11” key or “ALT + ENTER”. These will toggle between full screen and the original size.

Press “ESC” to escape (if necessary, click the “x” at the top right-hand corner)

It’s as easy as that. Once you’ve played an .avi file, you won’t want to use executables again.

PLAYING .AVI FILES ON A MODERN TELEVISION

If you have a modern “Smart” TV, it will have a USB port.

Copy the movie files to a memory stick/portable hard drive and place it in the USB port. When the menu appears, simply navigate using the
arrows on the controller. Not all “Smart” TVs can play all movie formats. If one movie format doesn’t work, try recreating the movie file in

another format.

If you’re intending to show a PC-created movie file on a Mac, ensure the Mac can cope with that format. For example, Macs may not be
able to cope with .avi formats although they can usually handle .mp4 and .mov files.
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PLAYING .AVI FILES WITH VIDEOLAN VLC MEDIA PLAYER

Many people, including Tonbridge Camera Club and the KCPA, use VideolLan (VLC Media Player), a free downloadable software for both PCs
and Macs. To download it, go to http://www.videolan.org/vic/index.html. Follow the instructions. A shortcut icon will be placed on the
desktop.

-
[Pt
VIS aistlis
g
The file can be played by right-clicking the file-name and selecting “Add to VLC Media Player’s List” from the menu which appears. You can
select more than one file by clicking the first file-name and CTRL + clicking the others and selecting “Add to VLC Media Player’s List”. If

you've set Videolan is the default media player, the show will open with a double-click.

PORTRAIT OF HASTINGS.avi
PORTRAIT OF LINCOLN.avi

PRAGUE - CH/
3 PRAGUE - CO|
PRAGUE - ELE
4 PRAGUE - LEF|

A | Py ety However, in order to obtain the very best results, you do need to tweak
- Convert with Switch Sound File Converter . . . .
oo s o the settings. Please contact me if you would like a detailed document
Play with Windows Media Player . .
Openvith , on how to achieve this.

Share with

PUB SIGNS - I

Norton 360 »
Restore previous versions

Send to »
Cut
Copy

Create shortcut
Delete

FILE TYPES AND FILE SIZES
FILE TYPES

As mentioned before, the show file created on page 3 will be a .psh file. | suggest you type “show or hide file extensions” in search facility
on main Windows screen and follow on-screen instructions to make file extension always visible.

Control Panel (4) FIG 32

'é‘! Make a file type always open in a specific program
&) Change the file type associated with a file extension

V Show or hide file extensions

Documents (23)

B CakeWalk Users' Guide.doc 'gﬂ Make a file t_"l'

] DRM_EN.d| o .
] DR EN.doc & Change the file
8] Address Change Form.doc -

always open in a specific program
associated with a file extension FIG 33

Music (2) l"' Show or hide file extensions
1] 066 to MP3.docx .
|4 31 Did Isign the letter that you typed up yesterday.wma DOCU ments \1[]4:| Falder Opticns
Files (194) @ PSEVT.docx Show or hide file extensions

During the course of producing a show, PSG will produce a number of files with the same name but different extensions:

e .pshis the main show file with links to music and images and should NEVER be deleted.

e .bak (Back-Up) file can safely be deleted after the .psh file is saved and closed.

e .b01, .b02, etc. are additional back-up files produced each time the file is saved and can safely be deleted after the .psh file is
saved and closed.

e .pxc files are huge with full copies of images and music. They are created automatically as you prepare your show. When you are
totally happy with the executable or movie file, the .pxc file will not be needed and can be permanently deleted. If you re-open
the .psh file, the .pxc file is automatically recreated.

FILE SIZES

ProShow can cope with image sizes of any size and shape, and with the majority of file formats.

Since most computers these days are powerful, with lots of RAM and hard drive capacity, there is rarely any need to resize your images. A
large file will retain quality when you zoom in whereas a small one won’t. Conversely, a larger file will take longer to upload, and some
machines may struggle with them.

AND FINALLY...
If you have any questions, please email me on philip.smithies@hotmail.co.uk.
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